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Payslip Screen 
This is the main screen and you should find everything you need to calculate a payslip here, with 
addition to the Employee Info button. 

 

Tax Year 

By default shows the 
current tax year set in 
the options screen but 
you can also select 
previous years when 
available. 

 

 

 

 

 

Frequency 
Depending on the employees pay frequency, this can be Monthly, Weekly, Fortnightly (2 weekly) 
or Lunar (4 weekly).  

Pay Period 
Monthly pay periods range from 1 to 12 with pay period 1 starting on the 6th of April and ending on 
5th of the following month. Weekly pay periods range from 01 to 52 with pay period 1 starting on 
the 6th of April and lasting for 7 days, the next period then starting on the 8th day. If the first pay 
period of the year is on a Thursday subsequent weekly pay period will always start on a Thursday 
and end on a Monday.  
 
Fortnightly pay periods start from 02 to 54 in steps of two. Period 54 is calculated using week 2 
basis. Lunar pay periods start from 04 to 56 in steps of four, pay period 56 is calculated using week 
4 basis. 
 
There is a pay-date box visible when calculating monthly in period 2 for tax years before 09/10. 
We use this to select an effective date before or after the 18th may  
 
Tip: For an easy way to select a pay period, use the Calendar. 
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Tax Code 
Defaults to the emergency tax code for the selected year, and can accept standard suffix codes and 
K, D, BR, NT, 0T codes. 

Basis 
There are two options, ‘cumulative’ and ‘week 1/month’; cumulative being the standard basis. You 
can change the default basis in the options. 
 
Cumulative basis uses figures to date plus this period to calculate tax and national insurance, 
whereas ‘week 1/month 1’ uses only the figures for this period. There are no rebates given when 
using ‘week 1/month 1’ basis. 

NI Code (Category) 
Selects the rate national insurance is calculated at, that reflects your employee’s circumstances. 

Director 
N. Not applicable. 

A. Calculate a Director on an annual basis 

P. Calculate a Director on a pro-rata basis, this is to be used for someone who becomes a director 
after the start of the financial year. When this field has been selected there will be a further field 
where you can enter the applicable number of weeks. 

Director's national insurance contributions are calculated the same way as an employee's, unless 
there is a change to their NI Category during the year, or this is the last period of the year, then it 
will be calculated annually. 
 
If an employee becomes a director in the middle of the year, select P and enter the number of 
weeks left in the tax year. Example 53, minus weeks worked as an employee. 

Method 
Exact percentage method for calculating NIC's uses a calculated method to work out national 
insurance, whereas table method produces the same results as the national insurance tables 
supplied by HMRC. 
Table method for calculating NIC's 

Selecting Payments 
Click on a row in the description column and select a description from the list. If there is not the 
description in the list, select custom and enter your own. 
 

• If the payment is Tax’ able, put a tick in the Tax’ able tick-box (T). 
• If the payment is NI’ able, put a tick in the NI’ able tick-box (N). 
• If the payment is Pension’ able, put a tick in the Pension’ able sick-box  

(Only available from the custom or definitions window). 
  
Then enter a value for the payment. 
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Selecting Deductions 
Click on a row in the description column and select a description from the list. If there is not the 
description in the list, select custom and enter your own. 
 

• If you want the deduction to be deducted before Tax is deducted, put a tick in the tax’ able 
tick-box (T). 

• If you want the deduction to be deducted before NI is deducted, put a tick in the NI’ able 
tick-box (N) 

• If you want the deduction to be deducted before any pension schemes are calculated, put 
a tick in Pension’ able tick box  
(Only available in from the custom or definitions window). 

• If the deduction is a Pension scheme then tick Pension and input the relevant information 
for Employee’s contribution, employer’s contribution and disregarded (See Pension 
Deductions). 

 
Then enter a value for the deduction. 

Brought Forwards 
This is where you can enter your P45 or totals from the previous period if the Employee started 
after period 1. 
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Calculators 
You can access calculators by clicking the ‘>’ at the end of a payments row. 
 

 

Overtime calculator  
The hours/rates calculator can be used to work out the gross amount due for overtime. Enter the 
number of hours, the overtime rate, and the type of overtime, i.e. 1.5 in the multiplier. The 
calculated values will be transferred to the payslip screen automatically and the number of hours 
and the rate will print on the payslip. 

Tax credits calculator  
Enter the information from the revenue i.e. number of days (units) and the rate. Please ensure 
that the ‘T’ and ‘N’ columns are blank as these net payments are made directly to the employee 
and no statutory deductions are made. 
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Salary calculator  
Select the salary tab. enter a salary value and either the number of days or hours to be paid. If you 
input days, the system will divide the salary figure by the number of working days held by the 
options window and multiply by the number of days that you have entered, e.g. if the default 
value for working days is 260 and you enter the annual salary of £12,000 and a period of 5 days, the 
result will be £230.77. Note: the default number of working days and hours can be changed on the 
options screen. 
 

 

Starters/ Leavers – Part week/month 
You can also pay the number of days in a specific month, i.e. a starter commenced on the 9th May 
and completed 19 days in a 31 day month. For this calculation enter the monthly salary. This 
method can also be used for leavers. 
 
Using the calculation screen will result in the calculated values being transferred to the Payslip 
screen automatically. 
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Calendar 
You can accessible the calendar from the calendar button at the bottom of the payslip screen. 

The calendar can be used to quickly select a pay period, 
when you click on a date in the calendar and click OK, 
the relevant pay period is transferred over to the payslip 
screen. 

 

 
 

Customize 
Select Options from the edit menu and 
the Options window will be displayed.  

 

The Default Function  
Here you can choose to see either the P45 
or payslip screen when you start the 
program. If you are mainly doing payslips 
then choose payslips. 
 

P45 Calculator Defaults  
Set the 3 default options to the most 
common type of P45 that you receive. This 
will save you keying them in each time. 

 

 

Payslip Defaults 
By changing the default values here, they will be used when you first start the software or click 
the new button on the payslip screen. Enter the most common values you use, for example, you 
may wish to enter opening pay period as ‘1’ while working in April. 
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Default Payments 
The first is the number of working days used in the salary calculator, e.g. the standard number of 
working days is 260 days a year (52 weeks X 5 days a week). The figure that you enter here will be 
used as the divisor for the salary that you enter. This is useful for calculating starters and leavers 
who only receive a part period payment. 
 
For example, a new employee is on £20,000 a year and the standard number of working days a 
year is 260. He has worked for 12 days in this pay period. His salary will be £923.08 
 
20000 divided by 260 times 12 = salary to be paid. The second field is for the contracted number of 
hours worked per week. This is very similar to the working days above, e.g. an employee is paid 
£300 a week and normally works a 40-hour week. He only worked 25 hours so the salary will be 
£187.50. 
 
300 divided by 40 times 25 = salary to be paid. 

Default Payslip Contents 
Print out a payslip to see where the fields appear on the payslip then enter a suitable title in each. 
The first is the payroll group name and this will be set to Your Pay group. The second field is for 
the company name. When you save a payslip you will be able to change the default Pay group. 

Default Payslip Type  
Select which of the 3 styles of payslip you use the most. 

Logo 
Firstly get your logo file into a compatible format. The file should be in one of the following 
formats: 
 
Bitmaps (*.bmp;*.dib), GIF Images (*.gif), JPEG Images (*.jpg), Metafiles (*.wmf;*.emf), Icons 
(*.ico;*.cur) 
 
Once you have created your logo file you can then store it somewhere easy to remember.  

Add Logo  
Click on the logo button on the right hand side of the options window. Find your logo, highlight 
it and click open and OK. The next time you print a payslip you will see your logo on it. 

Remove Logo  
To remove the logo click ‘Reset Logo’. This will remove the logo so you can apply a new one or 
leave the area blank. 
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Payment list  

 
 
This window can be activated in three different ways depending on where you are on the system:  

• Clicking on the edit menu/definitions/payments.  
• Right click on payment on the payslip screen. 
• Selecting “custom” from the payments drop down list on the payslip screen. 

 
 
Once the window is up, you can enter a new deduction title, defining whether it is allow-able 
against tax, national insurance and pension. 
 
Click ‘insert’ for a one off payment or ‘store’ to add it permanently to the list. 
 

SMP - Statutory Maternity Pay 
This is a minimum level of statutory pay to most employees who are off work due to giving birth 
or the arrival of a baby. It must be included in Gross pay at the time it is paid. PAYE and NIC's are 
then worked out in the normal way 
 

SSP – Statutory Sick Pay 
SSP is the minimum level of sick pay you must pay to most employees who are off sick for 4 or 
more calendar days in a row. It is paid for qualifying days (after an employee has served 3 waiting 
days) for employees with average weekly earnings of not less than the lower earnings limit for the 
payment of National Insurance Contributions. 
 
SSP must be included in Gross pay at the time it is paid. PAYE and NIC’s are then worked out in 
the normal way. 
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Payments for Expats 
There are two simple facilities for expats on the system. 

*Non Payable Payments 
If you put an ‘*’ in front of a custom payment, it will not be calculated as a payment but will be 
taxed if T is ticked on the payment row. 

Ex-Pat Tax-Back 
This function will calculate a Net to Gross figure and add the tax back into a payment; this will 
then be calculated again until the net value is as specified. Simply Tick Ex-Pat Tax-Back in the Net 
to Gross dialog. 

Deduction list 

 
 
This window can be activated in three different ways depending on where you are on the system:  

• Clicking on the edit menu/definitions/deductions.  
• Right click on deduction on the payslip screen. 
• Selecting ‘custom’ from the deductions drop down list on the payslip screen. 

 
Once the window is up, you can enter a new deduction title, defining whether it is deducted 
before tax, national insurance and pension. 
 
Click ‘insert’ for a one off deduction or ‘store’ to add it permanently to the list. 
 
You can delete a payment or deduction by selecting it in the list and then clicking the remover 
button. 

Student Loan Deductions 
Select Student Loans from the drop down screen in the deductions section of the on ‘payslip’ 
screen then enter the relevant figure from the deduction tables. You will need to manually record 
this value on your P 11. 
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Tax 
Each employee is given a PAYE (Pay As You Earn) tax code that reflects the tax allowances due 
against their pay. 
 
You normally work out PAYE on a cumulative basis. That is you take into account an employee’s 
previous pay and tax figures in the tax year to find out the PAYE to deduct from a payment. 
 
However, sometimes you need to work out PAYE on a non-cumulative basis Week1/month1 basis. 
In these cases, no account is taken of an employee’s previous pay and tax figures and each 
payment is taxed separately. 
 
There are also K codes, which instead of giving you a tax-free allowance actually add an amount 
to your taxable pay. 

Pension deductions  
To set up pension details insert a heading from the deduction list then right click to reach a 
further screen with three more settings. Select ‘%’ or ‘£’ and enter a figure under amount. 
 

 
 
Employee - This is the employee's deduction you want made. 
Employer - This is the employer's deduction you want made. 
 
Disregard - this is the percentage or value that must be deducted from the pensionable pay prior 
to the employee and employer calculations being made. 
 
Click insert and the values will be inserted when the payslip is calculated. 
 
NB. Pension schemes that have been authorized by the Inland Revenue allow employees to obtain 
tax relief on their pension contributions (Including any Additional Voluntary contributions) but 
not against their earnings for NIC purposes. This scheme is called the ‘Net pay arrangement’. 
Until you receive authorization you must not use the scheme.  
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Net to gross calculation 
Occasionally you may need to ‘gross up’ a net payment to arrive at the gross value before the 
deduction of tax and National Insurance. 
 
To operate Timesaver: Calc for Tax in this way, set the ‘conditions of payment’ - such as 
‘Frequency’; ‘period and basis’, etc., - as you would for a normal ‘Gross to Net’ calculation. 
 
Now click on the ‘Net Pay' box at the bottom right of the payslip screen or from the File menu to 
reveal the ‘Net to Gross Calculator’ Window. 
 

 
 
Enter the description of the payment you wish to make or select one from the list and enter the 
net pay target figure. 
 
NOTE: The ‘Tax’ and ‘NI’ e.c.t boxes allow you to decide the basis for calculation, just as you 
would in a normal ‘Gross to Net’ calculation. 

Cumulative Payments 
You may wish to calculate a series of payslips for an individual. When producing further payslips 
the values held and displayed as ‘C/F’ Cumulative will remain but will be changed to ‘B/F’. The 
‘Period’ will automatically advance when you press ‘Next’. 
(See commencing an employee’s next payslip) 
 
Enter or amend any payments or deductions due and press ‘Calc’ to perform the second 
calculation, which will update the cumulative 
 
IMPORTANT: If you intend to provide the individual with separate payslips for each of the pay 
periods, then you will need to store each calculation separately, changing the pay period 
accordingly. 
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Copy Payslip Information 
On the Menu bar in the Edit function there is a 'Copy facility'. When you are in the payslip screen 
the 'Copy' function will copy summary details of the payslip details 

View current payslip figures 
All the current values of a payslip displayed on the payslip screen 
can be accessed by selecting ‘View’ then Payslip Values from the 
menu bar. This includes employer’s contribution and pension 
deduction. 
 
 
 

 

View P11 Values 
Selecting ‘View’ from the menu bar can access the P11 values. The details can be copied to the 
clipboard for pasting into any other Windows product. 
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Additional Payslip Information 
This screen can be assessed threw the employee information button on the payslip screen. You 
will also be prompted to fill in this information when storing a new payslip or by selecting ‘Store 
As’ from the File menu. 

It is important you assign a different Employee 
reference number to each employee you manage, 
even if they do not have one. This information is 
used for RTI submissions to HMRC and they 
currently use it to identify the employee.  

 
 

 
Mandatory fields are marked yellow until filled in; the NI No. number will remain yellow if the NI 
number is invalid. 
 
The Payment date is the date payment is made to the employees Bank not the pay period date. 
 
All other fields should be self-explanatory. 

Payslips 
You should always save your payslips for later use; you will need to recall then when doing 
cumulative/sequential calculations.  

Store a Payslip 
Once a payslip has been calculated, you can save/store it by clicking on the ‘File’ menu, then 
‘Store’. This will activate the additional payslip information screen if needed. When you complete 
and confirm a window will be displayed that tells you the storage number of the new payslip. 

Duplicate a payslip. 
Recall the payslip you wish to duplicate and then from the ‘File’ menu select ‘Store As’ This will 
activate the additional payslip information screen. When you complete and confirm the entries a 
window will be displayed that will tell you the storage number of the new payslip. 
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Recall a Payslip 
Once stored, you can recall any payslip by simply clicking on ‘File’, then ‘Recall’. A window details 
all payslips held by the system and offers a choice of four sort sequences. Select the payslip you 
require by highlighting it and then pressing the ‘Recall’ button. 

 

Amend a Payslip 
This is only advisable before a payslip has been issued to an employee. To amend a payslip click 
on ‘File’ on the menu bar, then ‘Recall’. Make your changes then click on ‘File’ on the menu bar, 
then ‘Store’. 

Delete a Payslip 
Select a payslip from the list and click Remove. 

Print a Payslip 
Once a payslip has been calculated or recalled you can print it from the ‘File’ menu. 
There is a selection of three different payslip layouts to choose from. 

Commencing an employee’s the next payslip. 
Recall the last payslip for an employee then press ‘next’. You are now commencing a new 
calculation and the pay period has been advanced. You can now make changes were needed 
before clicking calculate and then store. The payslip will be assigned a new storage number; not 
overwriting its previous one.  
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Additional payment 
Making a second payment in a pay period is always an issue because it is impossible to determine 
the amount of statutory deductions previously deducted in that period; therefore you have to give 
the system sufficient information to proceed. 
 
The first step is to re-create the first payslip and ensure you have the same values. Remember that 
your brought forward values will come from the previous period’s payslip. 
 
Once the figures are the same add the new payments or deductions and recalculate. This will now 
give you the revised figures for the pay period. You can now store and print the payslip. 
 

P45 Calculator 
The P45 screen has been designed to allow you to quickly check details of any P45 you receive 
from a starter to ascertain whether it has been correctly prepared. Just enter the information in 
the relevant fields and click on ‘Calculate’ to display the correct answer in seconds. Should there 
be a discrepancy; a window will advise you of the difference. 

 

Copy P45 screen  
On the Menu bar in the Edit function there is a 'Copy facility'. When you are in the P45 screen 
click on the 'Copy' function and P45 details will be copied to the clipboard for pasting into any 
other Windows product 
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Add P45 figures to a new starter  
Press ‘New’ to start a new record. Enter the tax code from the P45. Then enter the P45 total pay to 
date into the gross pay and Tax Gross on the payslip screen. Then enter Total tax to Date in the 
Tax Paid area. 

Add P45 figures to an existing employee  
Recall the payslip and click ‘Next’ to start a new payslip. You will now have the figures from the 
previous payment brought forward. Change the tax code if needs be and add any figures on the 
tax forms to these figure. Note total pay to date must be added to both the Gross pay and Tax 
Gross boxes on the screen. 

Backing up Payslips 
Payslips are stored electronically in a database in  
‘…\Documents\My Payslip Database\Taxcalc_2013.mdb’.  

Make Calc for Tax stay on top of other windows 
You can make Calc for Tax stay on top of other program windows by clicking on the View menu 
and selecting ‘Stay on top’. This is useful if you want to check figures in applications and don’t 
want to keep switching between programs. 

Updates 
Each year the Timesaver: Calc for Tax software is upgraded with the new rates and bandwidths as 
decided upon by the Inland Revenue. 
 
Each time the software is re-issued specific instructions are given so that you will know what to 
do. 
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Contact information 
 

Address 
PAYEsoft Inc. 
PNB 508 
2034 Columbia Blvd 
St. Helens OR 97051 
 
US Registry No. 492762-98 
 

Support 
support@payesoft.com 
UK Phone: +44 (0) 208 123 3256 
 

Sales 
sales@payesoft.com 
US Phone: +1 (503) 438-4692 
UK Phone: +44 (0) 208 123 3256 
 

Website 
http://payesoft.com 
 

About 
Timesaver software from PAYEsoft cutting costs & saving time... 
 
Increasing productivity is a key issue for all businesses. The most basic of financial calculations 
can occupy Human Resources or Payroll staff for hours when they could be more profitably 
employed elsewhere. Now, PAYEsoft Inc. has developed a range of software packages which 
automate these time-consuming manual operations. 
 
PAYEsoft are dedicated to providing software that increases productivity. Our software is used 
where ever there is a need to replace time consuming operations, work prone to error or to 
display data accurately and quickly.  
 
For anther details on how the Timesaver series can help your staff to save time and increase your 
company's productivity, please contact us: admin@payesoft.com 
 
  

mailto:support@payesoft.com
mailto:sales@payesoft.com
http://payesoft.com/
mailto:admin@payesoft.com
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Installed files 
 
COMCAT.DLL VB Setup Runtime 
STDOLE2.TLB VB Setup Runtime 
ASYCFILT.DLL VB Setup Runtime 
OLEPRO32.DLL VB Setup Runtime 
OLEAUT32.DLL VB Setup Runtime 
MSVBVM60.DLL VB6 Runtime 
CALCFORTAX.EXE Calc for Tax Main Program 
TAXCALC.BK Database file (your payslips) 
COMDLG32.OCX Microsoft Common Dialog 
MSCAL.OCX Microsoft Calendar Control 
MSCOMCTL.OCX Microsoft Common Controls 
TDBGPP.DLL TrueGrid Runtime 
TODGUB8.DLL TrueGrid Runtime 
TODG8.OCX TrueGrid Runtime 
XARRAYDB.OCX TrueGrid X-Array libary 
 


	Payslip Screen
	Tax Year
	Frequency
	Pay Period
	Tax Code
	Basis
	NI Code (Category)
	Director
	Method
	Selecting Payments
	Selecting Deductions
	Brought Forwards

	Calculators
	Overtime calculator
	Tax credits calculator
	Salary calculator
	Starters/ Leavers – Part week/month

	Calendar
	Customize
	The Default Function
	P45 Calculator Defaults
	Payslip Defaults
	Default Payments
	Default Payslip Contents
	Default Payslip Type
	Logo
	Add Logo
	Remove Logo

	Payment list
	SMP - Statutory Maternity Pay
	SSP – Statutory Sick Pay

	Payments for Expats
	*Non Payable Payments
	Ex-Pat Tax-Back

	Deduction list
	Student Loan Deductions
	Tax
	Pension deductions

	Net to gross calculation
	Cumulative Payments
	Copy Payslip Information
	View current payslip figures
	View P11 Values
	Additional Payslip Information
	Payslips
	Store a Payslip
	Duplicate a payslip.
	Recall a Payslip
	Amend a Payslip
	Delete a Payslip
	Print a Payslip

	Commencing an employee’s the next payslip.
	Additional payment
	P45 Calculator
	Copy P45 screen
	Add P45 figures to a new starter
	Add P45 figures to an existing employee

	Backing up Payslips
	Make Calc for Tax stay on top of other windows
	Updates
	Contact information
	Address
	Support
	Sales
	Website
	About

	Installed files

